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1. System requirements
PC with 1.8 GHz (min.), 512 MB RAM, graphic resolution 1024 x 768, 40 GB hard
drive, USB interface / Windows 2000, XP, Vista and Windows 7

2. Software installation

First close all other applications.

Insert the software installation CD into your CD-ROM drive.

Installation will begin automatically. You should follow the on-screen instructions. If the
auto-start feature has been switched off on your PC, double-click to start the program
XXXX_setupx.X.XXXX_XXXXXX.eXe.

When installation is complete, you can start the program by double-clicking on the
program icon. Install the driver for the output device from the CD acc. to your
operating system and follow the instructions.

Language selection is automatic according to the country-specific version of Windows.
For country-specific versions of Windows where the program provides no individual
language version, the English version is automatically installed. You can override the

settings under > Options > Language setting.

3. Output devices supported by the program
The labeling and engraving software version 5.0 supports the following output
devices:

- Plotter
Labeling devices for labeling all current labeling elements that are used in switch
cabinets and plant construction.

- Plotter full size (DIN A3)
- Plotter half size (DIN A4)
- Plotter Basic half size (DIN A4)

- Engraving Unit

Engraving device for engraving plastic, aluminum and brass plates.

Connecting the engraving unit to one of the plotter versions provides you with access
to the following engraving devices:

- Engraver full size (DIN A3)
- Engraver half size (DIN A4)
- Engraver Basic half size (DIN A4)

Note:

The plotter versions and the engraving units can be run with this program solely via a
USB connection.
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- Office printer
To print any type of label sheet (DIN A4).

- Thermo transfer printer:
To print endless labels and endless strips

4. General program functions

Basic software structure

Various labeling devices such as plotters, engravers, office and thermo transfer
printers can be controlled using the labeling software. All labeling elements stored in
the database are assigned to the relevant labeling devices. When the labeling device
has been selected, the only labeling elements provided will be those that the particular
device can print or engrave.

If, for example, the office printer is selected as the output device, the label sheets set
up in the database are automatically provided for selection.

The corresponding designer enables new templates for various output devices to be
set up quickly and easily.

General procedure for using the labeling software
1. Choosing the labeling or engraving device
2. Select the labeling element

3. Labeling elements
4. Output of labeling data on the output device
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5. Brief instruction on how to use the labeling software

5.1 Choosing the labeling or engraving device

From the menu bar, select > Eile > New project. The window to select the labeling or

engraving device opens. When you have chosen and 2t evies

confirmed the relevant output device, the program
provides you with a list of all labeling element
manufacturers for the output device used.

When you have chosen the plotter or engraver and the
respective device is switched on and connected to your
PC via the USB cable, you can preselect the labeling
elements.

In this instance, the message appears:

> Do you want to use the element recognition
function of the plotter or engraver? <.

If you confirm by answering Yes, the

m Plotter Basic half size (DIN A4)

| A Engraver full size (DIN A3)

\“% Engraver half size (DIN A4)

\—‘i Engraver Basic half size (DIN A4)
@Ofﬁce printer DIN A4
giﬁTherma\ transfer printer

~Option:

[[] Use always this type of output device

software imports the identification of the

su pport plates placed from the plotter and ,‘e‘, Do you want to use the element recognition function of the

plotter or e

only provides you with the manufacturers of
the labeling elements that can be printed or
engraved on the support plates used.

ngraver?

[ ves |[ o

Cancel

5.2 Select the labeling element
Click on the relevant manufacturer to select the ...

labeling element required. It is B
then displayed on screen.

If you have switched on element recognition for
the plotter or engraver, the individual segments
will be displayed on screen. Double-click on the

segment required. This displays only the E

L] Al segments

manufacturers of labeling elements that can be
used with the support plate fitted.

Double-click to select the manufacturer and then the element to be printed. The

relevant template appears on screen.
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The menu bar displays the following information:

File Edit View Output Extras Options Window Help

NEHL|[S0 Mefxami WMo |9® Q@] Plot-Job- Plotter full size (DINA3) : Firma/Company - Schilder/Tags 14x10
| 7 u |Gl G| (o + & 3| -]/ 5 ||

- Plot job > Qutput to plotter
- Engraving job > Output to engraving device
- Print job > Qutput to office or thermo transfer printer

- Which output device was selected

- Which labeling element was selected

5.3 Labeling elements
You can choose from a variety of options to label tags or labels.

- Label straight onto the tag
Click on the tag to be labeled. The tag is selected and the toolbar shows the default
settings for selecting the font style, font size, etc.

Edi. View Ouly Exlras, Help
aaumsom:xnl lumvw&) Plot - Job - Flott fII ze (DINA3) : Firma/Company - Schilder/Tags 14x10
20 -] ulE=E . \ |

You can change the settings and
enter the labeling text directly.

When you have labeled individual
tags, you can copy, insert, delete, cut or remove tags as well as add new tags. In order
to select and process tags, drag the mouse to the tags that you want to work on. You
can access the action you require by right-clicking with the mouse on the drop-down
menu. Editing options are based on Excel.
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- Extended input of labeling data
If you wish to create multiple labels or consecutive labeling, or if you want to import
data from Excel or text files, double-click on the tag where labeling should begin.

A window subsequently opens enabling you to use the extended input options to
create labeling data. Click on Apply to go back show the entries on the tags.

File Edit View Output Extras Options Window Help
DoHY (S0 Mefx@a@i HRU | 9% | Q| @] Plot-Job-Plotter full size (DINA3) :
00 ]| 5 7 U ool [ 1[5

Firma/Company - Schilder/Tags 14x10

Multiple labeling r Consecutive labeling T Import labeling

Lines Line for consecutive labeling

Preview

AA|H 4 M

O

Insert tags t
’7 [ Eefore [ After all Iabeled tags (

[[] Show extended character set [[] Show symbal fonts anly
r— Plot settings

Size of Pen (mm) 0,18 ~ | Plotting speed (mm/s) 20 hd ﬂ Apply
Cancel

4
&= Base plate 1

5.4 Output of labeling data to the output device

When you have entered all labeling data, click on the printer icon in the toolbar.
The window for the relevant output device appears. You can then use this to enter all
the settings you require.
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6. Instruction on how to use the labeling software

6.1 Choosing the labeling or engraving device

Follow the menu path > File > New project. The window to select the labeling or

engraving device opens. When you have chosen and

Output devices

confirmed the relevant output device, the program T
provides you with a list of all labeling element ) Pioter Basic rar size o1 A0
manufacturers for the output device used. %EZZZZI?IL“;‘.f:;‘f’;?;‘,f;
When you have chosen the plotter or engraver and the | ewwer sescrarsce onao
respective device is switched on and connected to your ﬁfjmﬂf‘”:“
PC via the USB cable, you can preselect the labeling ‘
elements.
In this instance, the message appears:
> Do you want to use the element recognition
function of the plotter or engraver? <. = I%I‘
If you confirm by answering Yes, the
software imports the identification of the N ,

,0, Do you want to use the element recognition function of the
support plates placed from the plotter and & Liotter or engraver?

only provides you with the manufacturers of
the labeling elements that can be printed or
engraved on the support plates used.

| Yes || Mo

Cancel “

6.2 Select the labeling element
Click on the relevant manufacturer to select

the labeling element required.

If you have switched on element recognition for
the plotter or engraver, the individual segments
will be displayed on screen. Double-click on the
segment required. This displays only the

manufacturers of labeling elements that can be

Option:
E

[ Allsegments

used with the support plates fitted.

Double-click to select the manufacturer and then the element to be printed.

The relevant template appears on screen.

Page 9 of 59



The menu bar displays the following information:

File Edit View Output Extras Options Window Help S S
DoHL |50 WMefX Gl EBY 2| Q@A Plot-Job - Plotter full size (DINA3) : Firma/Company - Schilder/Tags 14x10

Block_Light - »|[so0 +]|® £ v |@EEE| [+ + e s |[ ][] ~]/%]

- Plot job > Qutput to plotter
- Engraving job > Output to engraving device
- Print job > Qutput to office or thermo transfer printer

- Which output device was selected
- Which labeling element was selected

If the labeling element, label sheet or endless labels are not available in the database,
you can use the designer variant to set these up at any time.

6.3 Labeling elements
You can choose from a variety of data input options to label tags or labels.

- Label straight onto the tag

Click on the tag to be labeled. The tag is selected and the toolbar shows the default
settings for selecting the font style, font size, etc.
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You can change the settings and enter the labeling text directly. When you have
labeled individual tags, you can copy, insert, delete, cut or remove tags as well as add
new tags. In order to select and edit tags, drag the mouse to the tag that you want to
work on. You can access the action you require by right-clicking with the mouse on
the drop-down menu. Editing options are based on Excel.
_File Edit View Output Extras Options Window Help D
DEHL |9 | U XxHa@E i MMV |20 |[QA[F| Plot-Job - Plotter full size (DIN A3) : Firma/Company - Schilder/Tags 14x10
DIN_1451 -] [20 w || B ru|EHEE] [+ + e 3|1 00 -] 5| \

6.4 Extended input of labeling data

If you wish to set up multiple or consecutive labeling, or if you want to import data from
Excel or text files, double-click on the tag where labeling should begin. A window
subsequently opens enabling you to use the extended input options to create labeling
data.

File Edit View Output Extras Options Window Help -
DEHYL SO WX Dl MMU | 9®|[Q[F| Plot-Job - Plotter full size (DIN A3) : Firma/Company - Schilder/Tags 14x10
DIN_1451 - v [0 +]|® s U |G GE G| |& + e s |[] F]]  ~]I5] |

Multiple labeling Consecutive labeling T Import labeling

Lines Line for consecutive labeling

Preview
O

Insert tags Repeat
( [ Befare O After all labeled tags (

[] Show extended character set [[1 Show symbol fonts only
—Plot settings

Size of Pen (mm) 018 =] Plotting speed (mm/s) 20 - ﬂ Apply
GCancel

== Base plate 1
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The top line of the window that has now opened provides you with information about
the tag or element as well as the number of tags available. Underneath the line of
information, a number of settings are available to change the labeling data. Using the
mouse, if you place the pointer on the relevant icon in the toolbar, the respective
function will be displayed.

You can change the following settings:

font style, font size, bold, underline, left align, center, right align, rotate labeling by
90° at a time, number of lines, line spacing.
Changed settings are automatically saved ready for when labeling commences.

Note:
The typeface selection in Bold or Italic is only available using the thermo transfer or
office printer.

Click on the arrow at the end of the toolbar to restore all factory settings.

In the bottom section of the window, check the < Show extended character set >
box. This opens another window that provides you with special symbols and special
characters.

The extended character set provides country-specific characters and special symbols
for selection. This means that labels for other countries can be created without any
problem.

Country specific character sets as Baltic, Greek, Turkish, Cyrillic etc. are provided
within the typeface ISO_3098.

In addition serif and ornamental typefaces can be chosen to be used spec. for
engraving.

If you have selected a plotter or an engraver as your device, you can modify specific
settings with reference to the relevant output device. The settings are displayed in the
lower part of the window.

In the middle of the window, you will see three tabs:

Multiple labeling — Consecutive labeling — Import labeling
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6.5 Multiple labeling

The relevant number of lines for editing will be opened according to the number of
lines set for each tag. You can now enter a suitable text and specify the number of
tags to be labeled with the same text in the > Repeat field. The entries are displayed in
the preview window. If required, you can also insert blank tags before or after the tags
you have labeled.

File Edit View Output Extras Options Window Help

DEHN (SO M X Gl i WMWY | 9™ Q|F]| Plot-Job - Plotter full size (DINA3) : Firma/Company - Schilder/Tags 14x10
DIN_1451 - ~] [0 ~]|B 7 U |GHGEE| | + « & | - -] % || \

Multiple labeling Consecutive labeling T Import labeling ILinE 1 ILinQ 2
MOTOR oN

Lines Line for consecutive labeling

>
Preview
O

‘MOTOR
AA|K 4 » M

Insert tags
’7 [] Before [] After all labeled tags ’7 lII

[[] Show extended character set [[] Show symbol fonts only

—Plot settings

Size of Pen (mm) 0,25 | Plotling speed (mm/s) 20 - ﬂ Apply
Cancel

E= You can only use character and symbols without ascender and descender beyond font size 2,6 mm !

4
= Base plate 1

6.6 Consecutive labeling

If you need to number labels consecutively, you should first specify the number of lines
on the Consecutive labeling tab in which the consecutive numbering should be
inserted. To enable you to do this, the > Lines for consecutive labeling field is activated
after the relevant lines.

After this, the program opens the consecutive labeling tab and the consecutive
labeling entries can then be added. You can enter the initial value, final value, text
prefix, text suffix, steps, counter and the number of repeats. You can opt for counting
to be ascending, i.e. the initial value is smaller than the final value, or descending,

i.e. the initial value is larger than the final value.
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The window is split into two sections: primary consecutive number and secondary
consecutive number. This enables you to create two consecutive numbers that are
linked to one another. You can choose whatever you like as a separator.

The example shows the primary range TP 1 to 5 and the secondary range 10 to
15-H, - has been selected as the separator, TP is thus the prefix text and —H is the
suffix text. The entries are displayed in the preview window.

|DIN_1451 20 BEiEEEREIEIEED [l +« % |1t +| o0 K
Multiple labeling T Consecutive labeling T Impaort labeling Line 1 -
TP1-10-H 3
: _ TP1-11-H
: ; . TP1-13-H
—Primary consecutive no.————— —~Secondary consecutive no.
TP1-14-H
Preset value (fixed) Preset value (fixed) 10 TP1-15-H
|_® | |0 Qe
Final value Final value 15 TP2-11-H
Steps Steps 1 TP2-12-H
N =
TP2-15-H
Repeat 1 Repeat
£ B IIl TP3-10-H
Leading zeroes (01/02/...) O Leading zeroes (01 /02/...) | TP3-11-H
. ; TP3-12-H
Counter ]Demmal ﬂ Counter IDemmaI LI TP3-13-1
TP3-14-H
TP3-15-H
[[] Show extended character set [1 Show symbol fonts only TP/_1n_H ¥
—Plot settings
Size of Pen (mm) 0,18 | Plotting speed (mm/s) 20 v ﬂ Apply

Cancel

When you click on the Apply button, the program takes you back to the previous tab.
If necessary, you can now add blank tags in front of each labeled tag. Likewise, you
can specify the number of series in the > Repeat field in the Multiple labeling tab.

6.7 Importing labeling data from files
If you click on the Import labeling tab, you can import data from files.

You can copy data from CAD/CAE programs, from E-plan, from text files or from
spreadsheet programs.
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An efficient transfer help tool is available to do this, which enables you to extract data
from various file formats.

Click on the Import from file button to search for the file to be imported, then select it
by clicking on the file name and finally click Open to prepare the file for importing.

File Edit View Output Extras Options Window Help

NDNEHEL |90 | WX @i BERU| 9™ |A[F| Plot-Job -Plotter full size (DINA3) : Firma/Company - Schilder/Tags 14x10
DIN_1451 - ~[ oo ~]|®B r U |GG |» ¢+« 3 |[ |~ >[5 |

DIN_1451 ] === o+ e +|[1 ~

Multiple labeling T Consecutive labeling T Import labeling |Line 1 |

Insert tag g
’7 [ Before [ Ater all labeled tags Import from file
[[] Show extended character set [[] Show symbol fonts only
—Plot setting
Size of Pen (mm) 0,18 = | Plotting speed (mm/s) 20 - ﬂ Apply

Cancel

4
== Base plate 1

A window opens up and the file

to be imported is entered into a e 1
AB 11 A w11 AB 11
AB 12 B w12 AB 12
table AB 13 [C W 13 AB 13

AB 14 A W 14 AB 14

AB 15 B W 15 AB 15

AB 16 C W 16 AB 16

AB 1.7 A W 17 AB 17

AB 18 B W 18 AB 18

AB 19 C w 18 AB 19

AB 1.10 A w 20 AB 1.10

AB 111 B w21 AB 111

AB 112 C w 22

AB 113 A W 23 [Optons

AB 114 |B W 24 [¥1Overwrite preview:

AB 115 = w 25

e L [] Ignore empty fields

AB 117 _|B w 27 [ Left to right

AB 118 C W 28

AB 113 |A W 29 Biiiad

AB 120 |8 w 30 Selected fields
Allfields
Done
Cancel

Page 15 of 59



In this example, an Excel file was chosen. You can now select certain fields, sections
or individual cells and copy the selected data by clicking on the Selected fields
button. You can also copy all the data from the file by clicking on the All fields button.
When you have finished copying, click on the Apply button.

This will close the window and the data will be displayed in the previous window.

|DIN_1451 vl {26 ~| 100 ~] S IETER [+« 3]t ~[oo ~[5

Multiple labeling T Consecutive labeling T Import labeling Line 1
AB 1.1
AB 1.2
AB 1.3
AB 1.4
| AB 15
| AB 1.b
AB 1.7
| AB 1.8
|
|

Lines

|AB 111

AB 1.9
AB 1.10
AB 1.11

Insert tags
’7 [[] Before [] After all labeled tags Import from file

[[] Show extended character set [[] Show symbol fonts only

— Plot settings

Size of Pen (mm) 0,25 | Plotting speed (mm/s) 20 v j Apply
Cancel

Note:
If you are importing data from text files, the data is not usually in a format available for
use. Various separators are available to enable you to separate the data properly.

You can use individual separators, or a combination of separators, such as Tab,
Space, Comma or Semicolon. You can also use other characters or letters. You can
activate this functionality by checking the < Other > box and then specifying your
requirement in the subsequent field, e.g. the letter B. Enter B in the empty field and
confirm your entry by clicking on OK.

Another option for separating when importing is to enter the number of characters.
Select < Fixed text length > and enter the number of characters after which a field
separation should be inserted, e.g. 4. Enter 4 in the empty field and confirm your entry
by clicking on OK.
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If you want to import an Excel, Access or E-plan file, the program automatically
recognizes the type of file it is dealing with and provides the first record or worksheet
to be copied. You have the option of selecting additional worksheets or tables for this
file. The first worksheet or the first table are displayed by default.

6.8 Insert graphical elements or pictures

If you have selected an office printer or thermal transfer printer for printing the labels,
you can place as well graphics or pictures with the format JPEG, Bitmap or GIFF.
Highlight the label and select from the main menu >_Edit > Insert picture or click on the
icon insert graphic or picture.

Browse for the graphical element you want to insert and confirm with OPEN.

The element will be shown on all endless labels and on all labels of the sheets.

If you have used the layout function for dividing the label into text fields prior to placing
the graphical element, each text field can also hold a graphical element.

In addition the graphical element can be rotated in 90° steps.

To delete the graphic or picture click on the respective icon or go from the main menu

to > Edit > Delete picture.

File Edit View Output Extras Options Window Help
DoHY | S| @dfX Ll @MY |2¢ AR Print-Job - Office printer DIN A4
~||B 7 u|=H=3| I
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7. Output of labeling data

After entering all labeling data, the labeled tags can be printed or engraved. When you
began working, you selected the printing or engraving device you wanted to use.

If you click on the Print icon, the relevant printing output window opens for the output
device being used.

7.1 Output on plotter
The settings and information are entered or are displayed on the tabs.

Plot options — Support plates

Plot options tab

Plot options T Support plates

[ Use pen inserted in pen holder

This tab enables you to set the following

[ Priming on pen change

parameters [ Choose different pen in the pen depot ’—_| mm O

[ Choose plotting speed to be used ,—_| nm. O
- only use pen inserted in pen ho'der Pen size for graphic elements mm
If you check this box, no pen is taken Plot speed o graphic lements I el . 018
gut of the pen de_-pot. Only the pen . o ‘ —
inserted directly in the pen holder will be | & : —

used. This option is therefore always
required if you need to use pens that
are not suitable for the plotter’s pen
depot.

&= Change / Add the support plates for the plotter marked in red!

- Priming on pen change

If you select priming on pen change, prior to labeling, the pen is taken to the
respective priming disk next to the pen depot and is primed so that labeling is clear
right from the first tag.

- Choose different pen in the pen depot

Two or more pens are displayed that should be used for this print instruction. If you
just want to use one plotter pen thickness, click on this option and choose the pen
to be used from the selection that subsequently appears.

- Choose plotting speed to be used

You can set different speeds for individual labeling sequences. If you just want to use
one speed, click on this option and set your required plotting speed from the selection
that subsequently appears.
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- Pen size for graphic elements

You have the option of creating layouts on tags. These functions are detailed in the
section entitled > Create layouts on tags <. This enables you for example to create
text fields with frames, borders, etc. You can specify a particular pen for these graphic
elements.

- Plot speed for graphic elements
This enables you to select a particular plot speed for drawing graphic elements.

- All selected tags will be printed
If you select this option, only the tags you have previously selected will be printed.

- All selected segments will be printed

With this option, only previously selected segments will be printed. You make your
selection by clicking on one or more segments on screen. You can select more than
one segment by holding down the Control key whilst clicking on the various
segments you wish to select.

Note:

If you are using the Plotter Basic half size (DIN A4) as the output device, some
options are not available for selection since this plotter has no pen depot and no
priming disk.

Support plates tab Plot options | support plates

Segment 1 : Firma/Company - Schilder/Tags 14x10

Segment 2 - Not mounted

O
This shows which labeling elements are | semens - notmounes O
being used and checks whether the SEE T
relevant support plate has been fitted O
for the plotter. If a support plate is .
missing or if the support plate is not

compatible with the labeling element, 0

the corresponding segment is Goncel |
h Ig hllghted In red . E=p Change / Add the support plates for the plotter marked in red!

Note:

The Plotter Basic half size (DIN A4) has no support plate recognition and therefore
no check can be made to ensure the correct support plates have been fitted.
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7.2 Output on engraver
The settings and information are entered or are displayed on the tabs

Engraving options — Tag contours — Support plates

Engraving options T Tag contours T Support plates Tool size

—Text and symbols

Engraving options tab e
When entering labeling data, various g::1:21?3?::5::‘“”““S“
engraving tools will be used depending on O e
the font size. The labeling window displays [SEr—
the depth of the engraving tool, the r

engraving speed, the RPM for the engraving

RPM

mm/s

Ol6] 19610
S161616]616),

mm/s

RPM

Jol b

spindle and penetration speed used for each

le]
©

=]
il3|®
8

labeling task. If necessary, you can change R |

the various settings as detailed below. E =

- Only one engraving tool and depth to be used

Two or more engraving tools are displayed that should be used for this engraving
instruction. Click this option if you only want to use one tool size and depth of
penetration.

- Only one engraving speed to be used.

Different engraving speeds can be set for individual labeling tasks. If you just want to
use one speed, click on this option and set your required engraving speed from the
selection that subsequently appears.

- Choose RPM to be used

You can set different RPMs for the engraving spindle for individual labeling tasks. If
you just want to use one spindle speed, click on this option and set the spindle
speed required (RPM) from the selection that subsequently appears.

- Only one penetration speed to be used

You can set different speeds for individual labeling sequences. If you just want to use
one speed, click on this option and set your required penetration speed from the
selection that subsequently appears.
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- Reverse labeling

This function enables you to reverse the labeling, thus effectively labeling the tag from
behind. This produces a label that can be read on the front without the surface of the
tag having been engraved. This makes it impossible to leave behind any dust particles
in the engraving itself (certain materials required).

- Speed for graphic elements

You have the option of creating layouts on tags. These functions are detailed in the
section entitled > Create layouts on tags <. This enables you for example to create
text fields with frames, borders, etc. For these graphic elements, you can set the
parameters for the engraving speed, RPM for the engraving tool, and the penetration
speed for the engraving tool into the material being engraved.

- All selected tags will be engraved
If you select this option, only the tags you have previously selected will be engraved.

- All selected segments will be engraved

With this option, only previously selected segments will be engraved. You make your
selection by clicking on one or more segments on screen. You can select more than
one segment by holding down the Control key whilst clicking on the various segments
you wish to select.

- Engrave tag contour
If you check this box, the program automatically takes you to the Tag contours tag.

You can then use this tab to set os e
parameters according to whether you wish | (7
to engrave tag contours, i.e. = , e slmens
outlines and any necessary holes. This o
option is used if, for example, you are using | | ozt cerioweny |
blank engraving plates or tags that have not | e T
been prefabricated. == =
Cancel
E Qe |
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- Engrave contour around tags with lettering only
If you check this box, a frame will only be engraved around the tag if it contains
lettering.

- Engrave contours around all tags
If you select this option, a frame will be engraved around all tags.

- Round frame corners
If you select this option, a combo box appears in which you can set the radius to the
corners. You can set radii from 1 mm to 5 mm, graduated in steps of .5mm.

- Engrave holes on tags with lettering only
If you select this function, holes, if designed, will be engraved only on tags containing
lettering.

- Engrave holes on all tags
If you select this option, holes, if designed, will be engraved on all tags.

- Engrave tag contour only

Checking this box will enable you to just engrave the tag contours. You can use this
option with thick materials to engrave contours in a two-stage process, if necessary.
First choose a small depth of penetration and then fully engrave the material.

- Speed for tag contour

You can use this section to set the engraving speed, the revolution speed (RPM) of the
engraving spindle and the penetration speed for the engraving spindle for the material
being engraved.

Note:
In principle, lettering is always engraved first, followed by the contours, as long as the
relevant parameters have been set.

After the engraving job, the engraving device stops and asks if you require to fit
another engraving spindle and set another penetration depth, so that the material can
be engraved right through to the base.

With thick materials, this can be done in two stages.
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Support plates tab

Engraving options T Tag contours T Support plates Tool size

This shows which labeling elements are | ———— ——
being used and checks whether the Ceiemilnis
relevant support plate has been fitted
for the engraver. If a support plate is
missing or if the support plate is not
compatible with the labeling element,
the corresponding segment is
highlighted in red.

PEO®EE
OHEEEEE

Note: ‘D
The Plotter Basic half size (DIN A4)
has no support plate recognition and

therefore no check can be made to ensure the correct support plates have been fitted.

7.3 Printing on an office printer
The first time you send your data to be printed on an office printer, the following
message appears on screen:

,-"'_"":, You have not selected a system printer for printing or the printer
- was deleted. Please assign prior to printing a suitable output
device, using the button "Printer” !

When you confirm the message by clicking on OK, a window opens with the Printer
tab showing all printers available:

Printer assignment and settings

Office printer Ad T Endless printer

Select Printer

Microsoft XPS Document Writer £
Fax

VP500 Plotter DIN A3 =
VP100 Plotter

VP500 Engraver DIN A4

VP500 Plotter DIN A3 (Kopie 1) >

Not usable printing areas at top and left (mm)

Test page
Apply

Close
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Now choose the printer you require and click on the Test page button.
A < Portrait test page > sheet is then printed on the relevant printer. Measure the top
and left margin with a ruler and enter the values in the respective boxes. These entries
are needed because all printers have different margin settings for text.

Click on OK to save these values. The program will then take you to the

< Print options > window,
where you can set the

following parameters for No. of prints [ ]
the printout.

Print options T Tag contours

[] All selected tags will be printed

[ Plot frame around lettering |

- Specify the number of label sheets to be printed.
- Specify whether only the selected tags should be printed.
- Specify whether a frame should be printed around the lettering.

This function is useful if you want to cut out printed tags with scissors.

If you check this box, the program automatically takes you to the

Tag contours tab.
Print options T Tag contours Printer

Plot frame around tags with letterings only

Frame

[ Plot frame only

OK

Cancel |

By clicking the relevant box, you can choose whether to plot a frame around tags with
lettering only or to plot a frame around all tags on the sheet. If you select Plot frame
only, only the frames without the lettering will be printed.
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7.4 Printing on a thermo transfer printer
The first time you send your data to be printed on a thermo transfer printer, the
following message appears on screen:

You have not selected a system printer for printing or the printer
was deleted. Please assign prior to printing a suitable output
device, using the button "Printer” !

oK

When you confirm the message by clicking on OK, a window opens with the Printer
tab showing all printers available.

Office printer A4 T Endless printer

Now select the TT printer

requ ired. Select Printer

Microsoft XPS Document Writer Ta
Fax

VP500 Plotter DIN A3
VP 100 Plotter

VP500 Engraver DIN A4
VP500 Plotter DIN A3 (Kopie 1) ¥

Increase size of tag 1,000

Apply

m

Close

The < Increase size of tag > setting enables you to adjust lengths
for unlimited strips (Scale factor).
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Click on OK to save these settings. The program will then take you to the
Print options window, where you can set the following parameters for the

printout:

- Specify the number of prints required.

- Enter the distance from left margin of the printing area.

- Specify whether only the selected tags should be printed.

By clicking on the tab Strip options you can modify the strip output.

iPrint options! T Strip options Printer
Mo of prints 1
Distance from left margin of printing area 0,0 mm
[[] All selected tags will be printed
oK |
Cancel ‘
Print options T istrip options Printer
Increase size of tags to compensate width of terminal blocks
—Raster mark showing a
@® None O Last O Al
— Raster mark
@ Line ¢ Dot
ok |
O
Cancel |

- Increase size of tags to compensate width of terminal blocks
With the change of the value the width of the tag segments can be adapted to the

terminal block size.

- Raster mark showing as

Selecting, if raster mark should be plotted, either All after each segment, Last only at
the end of last segment or None.

- Raster mark

Selecting, if raster mark should be plotted as Line or Dot.
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8. Create layouts on tags

If you want to arrange text fields or graphic elements on tags, the program has a
user-friendly layout option that you can use for this purpose. This function is helpful
when you want to divide a tag into various fields. It gives you the opportunity to use
various font styles, font sizes and symbols in the individually created text fields. This
function is also useful if you want to create individual labeling fields on prefabricated
rating plates.

Call up the tag for which you need to create a layout, select a tag and select
> Edit tag layout from the drop-down menu.

(File Edit View Output Extras Options Window Help
DEEHL S| XBamlmi HRU|(2¢ Q[ Plot-Job -Plotter full size (DIN A3)
DIN_1451 2.0 wm || s u === e v e 31 00 ~|]| "

MNew labeling

Insert tag
Delete tag

Edit tag layout

Base plate

Segment
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After choosing the layout, the following window appears on screen.

~Tag size (mm) —Tag size (mm)
[ 2650 | x [ 2650 | [ 2680 | x [ 2680 |
~Add component rAdd component
@ Text field & Text field
O Text field with frame O Text field with frame
O Circle / Ellipse Q Circle / Ellipse
O Rectangle O Rectangle
O Separator line O Separator line
~Edit ~Edit
Duplicate Duplicate
Delete Delete
Delete all Delete all
~Align rAlign
8 T
= = - I= =| @ | &
il lt
- Coordinates ~Coordinates
Left margin Upper margin
| 115 | \ 1.40 |
Width Height
[ 22 | \ 8.80 |
rZoom Zaom
Enlarge | Reduce | Enlarge | Reduce I
Save as | Save as |
Apply | Apply |
Cancel | Cancel |

The tag size is displayed in the top left field of the window.

Underneath that, you will see various components available that you can set up on the
tag. For example, if you want to create a < text field with frame >, click on the
relevant component. You should then use the mouse to position the cursor in the
right-hand side of the window in the tag displayed there, click with the mouse to
specify where the text field should begin, and use the mouse to define the text field.
This will create your text field.

Now you can click on the text field and move it to wherever you want it. You can also
enter the coordinates, such as the distance from the margin, height and width of tag,
directly into the relevant fields and confirm by pressing Enter. The entry is immediately
applied and the preview is updated.

Note:

It is easy to inadvertently move the graphic elements you have created when you click
on them with the mouse. In order to avoid moving the elements in error, you can fix
their positions by calling up the drop-down menu.

After fixing the position, you can also change the coordinates, size and position of
graphic elements.
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If you are using a plotter or engraver as your output device, you can measure the text
fields with the plotter. To do this, click on the text field whose measurements you wish
to take and select > Take Measurement of text field function from the drop-down

menu.
The following Window 0PENS UP: 1y ae ot e
Insert a pen directly into the writing {mrdmatejm v o 7552_00 —

arm pen holder and click on the left x [ o,z | [ 538 | ™ || ®1000mm
Initial position button. The plotter Y [ o0gs | [ 57 | ™ || 5 000mm
moves to upper left corner of the total © 0.025mm

plot area. You can now go to the text —\l j —Pen Up/Down

field in the top left-hand corner and ﬂ ﬂ 1| d _\| _V|
use the cursor key to take the tip of ﬂ _'l :

the pen right to the corner of the text Bpply

field. You can choose the step size il posiion_| il posiion_| Cancel

for each click of the cursor button.

Once you have defined the upper left corner, go to the lower right corner of the text
field by clicking on the second Initial position button. Proceed as before. When you
click on Apply, the coordinates will be applied.

You can duplicate or delete components that have been created.

You also have options available for setting the alignment of text fields or graphic

elements that have been set up.

rTag size (mm)

26,50 | X ‘

26,50

rAdd component

O Text field

O Text field with frame
@ Circle /Ellipse

O Rectangle

© Separator line

rEdit

Duplicate
Delete

Delete all

0

rCoordinates

rZoom

Enlarge

Reduce I

rTag size (mm)

\ 26,50 ‘x|

26,50

Add

O Text field

O Text field with frame
@ Circle / Ellipse

O Rectangle

O Separator line

Save as
Apply
Cancel
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If, as shown in the example, you have used the mouse to click on the three
components whilst holding down the Control key and then clicked on the Vertical
alignment button, the elements created are aligned vertically. Other layout options are
available.

You can alter the size of the preview window to make it larger or smaller.

Once the layout is completely finished, there are two options available for you to apply
the layout:

Click on the Apply button to apply the layout to the previously selected tags. You can
now enter labeling data straight into the fields.

If you want to save this layout on the tags, click on the Save as button. You then need
to save this tag with the layout you have created with a new name. When you want to
use this labeling element with the layout at a later date, you can call up the labeling
element in the > User defined < folder.

9. Designer / Layouter
This is used for setting up your own marking elements, label sheets, endless labels or
endless strips, engraving tags or rating plates for engraving.

There are 4 different versions of the Designer/Layouter.
These can be selected on the menu by clicking on > Extras > Designer / L ayouter for

File Edit View Output [Extras] Options Window Help
0 & ) Send HPGL file |

=TT

Designer / Layouter for 4 Tags and strips (Plotter)
Layouts Tags (Engraver)
Lot le T Label sheets (Office printer)
Endless labels and strips (Thermal transfer printer)

|
|
User elements I

Shift of

- Tags and strips (Plotter)

- Tags (Engraver)

- Label sheets (Office printer)

- Endless labels and strips (Thermo transfer printer)
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9.1 Setting up marking tags and strips for plotters
The Designer is called up using the following menu item:

> Extras > Designer/Layouter for > Tags and strips (Plotter).

The following window opens up:

Here you can create a new
marking element by clicking
on the New button.

First enter the name of the
marking element you wish to
create in the left-hand
window.

Next, you have to make the following settings:

Tags and strips (Plotter)

User elements and strips

50x25

—Support plate

(& Use element recognition

@® [Specify type of Upport piate)

|Umversa\ support plate A4 (half size)

DIN A3 (full size)

DIN A4 (half size)

=]

1/4 Segment

Element
(& Design tags within single group
© Design tags within multiple groups
O Design strips

e |
Delete
[
I =

e |

[] Plotter and Engraver

== Select the support plate and type of element.

Use the plotter's support plate recognition function.

Close

If you have a plotter with support plate recognition, it is advisable to use this function
to make it easier later on to find the marking element that you have created. To do this,
the plotter must be switched on and the relevant support plate positioned on the

plotter.

If you do not want to use support plate recognition, or are using a plotter with no
support plate recognition function, click on Specify type of support plate.
Now you have to select the support plate on which you want to set up the tag or

element.

In the next stage you define the properties of the marking element.
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Here you can choose between three options:

- Design tags within single group
The marking element has only one tag size.

- Design tags within multiple groups
The marking element has two or more tag sizes.

- Design strips

I SimEaNRsSNARNABNARNABNRR

With this function you can create marking strips with the size needed, dividing them
into horizontal and vertical sections.

Selecting one of the dividing directions opens another window for entering the
additional strip parameter.

9.1.1 Design a marking element with
one tag group

Enter the tag parameters for the marking
element.

If you do not have the exact data to hand,
it is easy to use the plotter to measure the
tags (recommended).
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To measure using the plotter, all you have to enter is the number of tags along the
X-and Y-axes. All the other data can be easily calculated using the program and with
the help of the plotter.

You can also specify the sequence in which the tags will be labeled. The sequence for
labeling can either be from Upper left > to Upper right (line by line), or from Upper left
> to Lower left (column by column).

Attention:

For processing to continue, it is essential that the plotter is switched on and the
marking element which is to be set up is positioned on the plotter, with the appropriate
support plate. Insert a pen directly into the plotter's pen holder. As an option, there is
also an optical measuring tool available which you can use to calculate and specify the
tag parameters. This tool is inserted like a pen directly into the plotter's pen holder.

When you have entered all or just some of the tag parameters, but at least the number

of tags along the X- and Y-axes, click on the Take measurements button and the
following window opens up:

Take corner measurements of tags

To take measurements, proceed as follows:

—First tag —Last tag —Steps
Upper left Lower right Upper left ) 10.00 mm
(O 0.025 mm
‘ ‘ ‘ —Pen Up/Down
‘ Initial position | Initial position | Initial position ‘ Cancel

First of all, specify the exact position of the upper left corner of the first tag in the
matrix. To do this, click on the Initial position button left in the first tag window. The
plotter's writing arm now moves to the upper left corner of the plotter field. You can use
the relevant cursor buttons as shown to move to the exact position of the upper left

corner of the first tag.
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You can choose the step size for each click of the cursor at the top right of the
window. When you have moved to the position for the corner, you can use the

Pen Up/Down button to check that you have reached the exact position. The relevant
coordinates are displayed in mm, from the starting position of zero. Now specify the
exact position of the lower right corner for the first tag.

Do this following the same procedure as detailed above for locating the upper left
corner.

Now specify the upper left corner of the last tag in this matrix.
Go to the last tag bottom right and proceed just as before.

Specifying these three points completes all measurements for this marking element.
You can now save the values you have calculated by clicking on the Apply button.
The < Take measurements > window is closed and the program takes you back to
the previous page.

If you also click on the Apply button here, you will see the marking element that has
been set up. You can now check that all data have been correctly calculated. If any
error messages or notices are displayed, you should check your data again or allow
automatic correction.

Having completed the marking element, you now also have the option of positioning
text fields and graphic elements on the tags. Creating text fields like this is always
useful if you want to divide the tag up into different fields, so that you can later use
different text sizes, font types or symbols on the tag. See Section 8 of this manual for
information on how to set up a layout.

After you have specified the design and, if you wish, also the layout, click on Back to
close the Designer or Layouter.

The program takes you back to the main window, which you can then close by clicking
on the Close button.

You can select the labeling element you have created in the folder
> User defined under > Manufacturer and call it up for lettering.
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9.1.2 Design a marking element with more than one tag group
To set up groups of tags of different sizes, you proceed exactly as described in the
previous section.

Tags: 100x20

Label parameter

In order to assign t_he tag groups, | = ST s
on the left of the window you must e wa [ 1"

. . Start of first tag X /'Y [ Jem
specify appropriate names for the et [ ] e

different tag groups. Once you
have specified the name for a tag
group, you can then enter the tag
parameters and measure the tags

and then create a layout if required.

When you have finished one tag |
group, you can set up more tag
groups.
9.1.3 Design marking strips
You have already specified the name for the marking strip, X-strip.
Strips: Streifen XYZ
— Strip parameter — Strip layout
Lengthwi
Strip orientation |h0rizonta| L] St
Partition 1 mm Crosswise ‘
Strip length / width | 190,00 | / | 30,00 | mm Partition 2 8,00 mm Crosswise ‘
No. of strips Partition 3 mm Crosswise ‘
Start coordinates X /Y | 2,00 | / | 10,00 | mm Partition 4 mm - ‘
Strip distance mm Partition 5 mm ‘
Take measurements ‘ Apply ‘ |, ............................ épply \|
Back I
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The next thing to do is to define the strip parameters:

First select the alignment of the strip. Lay the strip(s) vertically or horizontally on the
plotter.

Then enter the length and width of the strip, followed by the number of strips lying on
the plotter.

By using the Take measurements function, it is easy to calculate the start coordinates
and the strip spacing. Proceed exactly as described in the previous section.

After you have measured the strips and pressed Apply, you can specify a layout for
the strips in the right-hand section of the window.

You can subdivide the individual strips using horizontal and vertical scale factors.

First, if required, divide the strips into horizontal sections.

First define the height of the first section, by entering the height in mm in the

> Partition 1 field. The remaining height is then transferred into > Partition 2. In this
way, you can subdivide the strips into a maximum of 5 sections. When you have
finished dividing them up into sections, first click on the Apply button. This completes
the horizontal subdivision.

Next, you can make a vertical subdivision for each section. Click on Crosswise for the
relevant strip.

Then the following window opens up:

—Strip size (mm)
To enter the required subdivision of the strip, proceed as w000 | x [ 000 ]
follows: Used width (mm)
Remaining width 90,00
First enter the width and then the number of tags. ~Pariiioning
By clicking on the Add button, the data are transferred to the et () i

| 190,00 | | 1

field below. If the strip is not yet fully divided up, you will be
shown the length of strip that is still available. Now you can
specify other tag widths.

When you click on Apply, the program takes you back to the =~ [**
previous window and displays the subdivision that you have

specified.
In this way you can subdivide the individual sections using Apply
different tag widths in succession as required. e
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When you have finished all the subdivisions, close the Designer.

You can select the labeling element you have created in the folder
> User defined under > Manufacturer and call it up for labeling.

Note:
If you have created the labeling data for a strip and are producing the plotting data on
the plotter, there is the opportunity to define various options for plotting.

On the index card Strip options, you can determine whether cutting marks as
separating lines or dots should also be plotted.
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9.2 Setting up engraving tags for engraving units

Call up the Designer under > Extras > Designer/Layouter for > Tags (Engraver).

The following window opens up:

Tags (Engraver)

Here you can create a new o [ =
engraving element (individual | = o Dekte
tags Or tag groups) by CIiCking |Unwawsa\ support plate A4 (half size) J *‘
on the New button_ DIN AZ (ful size) DIN Ad (half size) 114 Segment %
First enter the name of the

engraving element you wish o e |
to create in the left-hand Bl
window.

Engraving material ’h‘ Material thickness ’T‘ mm Close

Then you can define whether

you want to use the plotter's support plate recognition function.

Use the plotter's support plate recognition function.

If you have a plotter unit with support plate recognition, it is advisable to use this
function to make it easier later on to find the engraving element that you have created.
To do this, the plotter must be switched on and the relevant support plate positioned

on the plotter.

If you do not want to use support plate recognition, or are using a plotter with no
support plate recognition function, click on < Specify type of support plate >.

Now you have to select the support plate on which you want to set up the element.

Then you define the engraving material and enter the thickness of the material in the
box at the bottom of the window.
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In the next stage you define the properties of the marking element.
Here you can choose between two options:

- Design tags within single group

The engraving element has only one tag size.

- Design tags within multiple groups
The engraving element has two or more tag sizes.

- Design strips

With this function you can create marking strips with the size needed, dividing them
into horizontal and vertical sections.

Selecting one of the dividing directions opens another window for entering the
additional strip parameter.
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9.2.1 Design tags within single group

Tags (Engraver): 20 x 30

—Label parameter

Tag shape Square / Rectangle

[ Automatic tag partitioning

Tag width / height

No. of tags X/ Y

/ mm
!
/ mm

Start of firsttag X/ Y

.

1
000

Tag distance X/Y

Orientation of tags |Upper left -> Upper right ﬂ

Take measurements ‘ Apply |

Engraving material |Plastic j Material thickness D:S mm Back

Now there are various ways you can create your engraving tags.

- You want to create your tags on a blank plate.

First define the shape of the tag, square/rectangle or circle/ellipse.

Then enter the required tag size.

Now click on < Automatic tag partitioning >.

When you click on the Apply button, the tags you have created will be displayed.

- You want to enter the data for an existing tag plate.
Enter the tag parameters for the pre-existing tag plate.

If you do not have the exact data to hand, it is easy to use the engraver to measure
the tags (recommended).

To measure using the engraver, all you have to enter is the number of tags along the
X-and Y-axes. All the other data can be easily calculated using the program and with
the help of the engraver. To do this you need the optical measuring tool that you will
receive from us.

You can also specify the sequence in which the tags will be labeled. The sequence for
labeling can be either from upper left > to upper right (line by line), or from upper left
> to lower left (column by column).

Attention:

For processing to continue, it is essential that the engraver is switched on and the
engraving element which is to be set up is positioned on the engraver, with the
appropriate support plate. First take the engraving spindle out of the engraving head
and then insert the optical measuring tool into the engraving head.
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When you have entered all or just some of the tag parameters, but at least the number
of tags along the X and Y axes, click on the Take measurements
button and the following window opens up:

Take corner measurements of tags- - -
To take measurements, e e B
Upper left Lower right Upper left @ 10.00 mm

proceed as follows: X o] e ] mm || x | (Vs soname

Y [ oo | [ tew | mm i ™ O 0100 mm
First of all, specify the exact N N N peem
position of the upper left corner | | .| < .| = 'Pe”j“’““’”ﬂ
of the first tag in the matrix. To 7| 7| |
do this, click on the Initial — |
position button left in the first —— neaptr | nitpen| e

tag window. The engraver's

engraving arm now moves to the upper left corner of the engraving field. You can use
the relevant cursor buttons as shown to move to the exact position of the upper left
corner for the first tag.

You can choose the step size for each click of the cursor at the top right of the
window. Go to the exact position of the top corner. The relevant coordinates are
displayed in mm, from the starting position of zero. Now specify the exact position of
the lower right corner for the first tag.

Now specify the upper left corner of the last tag in this matrix. Go to the last tag bottom
right and proceed just as before.

Specifying these three points completes all measurements for this engraving element.
You can now save the values you have calculated by clicking on the Apply button.
The < Take measurements > window is closed and the program takes you back to the
previous page.

If you also click on the Apply button here, you will see the engraving element that has
been set up.

You can now check that all data have been correctly calculated. If any error messages
or notices are displayed, you should check your data again or allow automatic
correction.

Now the engraving element is created.
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If you now want to make holes or cutouts in the tags you have created, or round off the
corners, click on the Holes, cut-outs, frame corners button.

The following window then opens up:

—Tag size (mm})

Here you can round off the corners by [ som ] x [ 20m
clicking on the > Round frame corners —
field and selecting the radius. Round frame comers

Radius 20 ~|mm

You also have the option of making holes |
or cutouts in the tag. © Circular
To do this, go to the tag and with the (B e
mouse draw a circle or a cutout. Later you |[**
can use the coordinates to define the —

position and size of the circle or cutout e
exactly. —

Duplicate

—Align

There are a number of alignment functions I

avallable' ~Coordinates

Center location Center location
Use the Apply button to save the dataand || "=® | [ 0 |

Close the WindOW Diameter (X} Diameter (Y}
' [ 1600 | [ 1600 |

rZoom
Enlarge | Reduce |
Apply |

Cancel |
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Having completed the engraving tags, you now also have the option of positioning text
fields and graphic elements on the tags. Creating text fields like this is always useful if
you want to divide the tag up into different fields, so that you can later produce
different text sizes, font types or symbols on the tag.

To do this, click on the Layout for text and graphics button.

See Section 8 of this manual for a description of how to set up a layout.

After you have specified the design and, if you wish, also the layout, click on Back to
close the Designer or Layouter.

The program takes you back to the main window, which you can then close by clicking
on the Close button.

You can select the engraving element you have created in the folder
> User defined under > Manufacturer and call it up for engraving.

9.2.2 Design tags within multiple groups

Tags (Engraver): 60x20
e o ‘ - Label parameter
Tag shape [ Square/Rectangle |-
| Tag width / height | | 1| | mm
| No. oftags X /Y | | 1| |
Start of firsttag X /Y | | 1| | mm
Tag distance X/Y | | 1| | mm
Orientation of tags |upper left-= Upperrignt _~|
| |
|
|
Engraving material |plastic ~l Material thickness mm Back ‘

To set up groups of tags of different sizes, you proceed exactly as described in the
previous section.
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In order to assign the tag groups, on the left of the window you must specify
appropriate names for the different tag groups. Once you have specified the name for
a tag group, you can then enter the tag parameters and measure the tags and then, if
you wish, add holes, cutouts and radii.

Then a layout can be created. When you have finished one tag group, you can set up
more tag groups.

9.2.3 Design marking strips
You have already specified the name for the marking strip, X strip
The next thing to do is to define the strip parameters:

First select the alignment of the strip.

Lay the strip(s) vertically or horizontally | s
on the engraver. e e e
Then enter the length and width of the / e }
strip, followed by the number of strips sancoranesxy [ 500 |/ [500 mm | |pamons [ 900 ] |
lying on the engraver. == = ‘
By using the < Take measurements >

Enoraving materal [prasse <] ateralthickness mm Back

function, it is easy to calculate the start
coordinates and the strip spacing.
Proceed exactly as described in the previous section.

After you have measured the strips and clicked on Apply, you can specify a layout for
the strips in the right-hand section of the window.

You can subdivide the individual strips using horizontal and
vertical scale factors.

First, if required, divide the strips into horizontal sections.

First define the height of the first section, by entering the height in mm in the

> Partition 1 field. The remaining height is then transferred into > Partition 2. In this
way, you can subdivide the strips into a maximum of 5 sections.

When you have finished dividing them up into sections, first click on the Apply button.
This completes the horizontal subdivision.

Next, you can make a vertical subdivision for each section. Click on Crosswise for the
relevant strip.
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Then the following window opens up:

— Strip size (mm)
300,00 | X | 10,00
To enter the required subdivision of the strip, proceed as Used widh (mm)
fO”OWS Remaining width
— Partitioning
First enter the width and then the number of tags. Width (mm) No. oftags

By clicking on the Add button, the data are transferred to the |_ow T o
field below. If the strip is not yet fully divided up, you will be ”
shown the length of strip that is still available. Now you can
specify other tag widths.

r Edit

When you click on Apply, the program takes you back to the
previous window and displays the subdivision that you have

specified.

In this way you can subdivide the individual sections using S =
different tag widths in succession as required.
When you have finished all the subdivisions, close the Designer.

You can select the labeling element you have created in the folder

> User defined under > Manufacturer and call it up for labeling.

Note:
If you have created the labeling data for a strip and are producing the engraving data
on the engraver, the horizontal and vertical separating lines will be engraved.
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9.3 Setting up label sheets for office printers
Call up the Designer under > Extras > Designer / Layouter for > Label sheets
(Office printer).

The following window opens up:

Here you can create a new label sheet by Label sheets (Office-printer)
clicking on the New button. First enter the TS e
name of the label sheet you want to create in
the window.
Import
=TT
|
Close

Then click on Edit and another window opens:

Labels: Label ABC

—Label parameter

Now you have to enter the appropriate tag
parameters for your label sheet here. If you
do not have the data directly to hand, then

Tag width / height | 000 [/] 000 | mm

MNo. oftags X/Y | 1 | ! | 1 |

you must enter the width and height of the Eamees N 000 [ 000 [
tag, the distance from the top left-hand Tag distance X /Y | 0000 |7 [ 0000 | mm
corner of the first tag (Start CoordinateS) and Orientation of tags |Upper|eﬂ—> Upper right j

the tag spacing along the X- and Y-axes,
using a ruler. You also have to enter the .
number of tags along the X- and Y-axes. _ v |

You can also specify the sequence in which , , |

the tags are printed.
Back
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The sequence for labeling can be either from upper left > to upper right (line by line),
or from upper left > to lower left (column by column).

When you click on the Apply button, the tags you have created are displayed on the
screen.

Having completed the labels, you now also have the option of positioning text fields
and graphic elements on the labels. Creating text fields like this is always useful if you
want to divide the label up into different fields, so that you can later use different text
sizes, font types or symbols on the label.

To do this, click on the Create layout for text and graphic button.
See Section 8 of this manual for a description of how to set up a layout.

After you have specified the layout if you wish, click on Back to close the Layouter.

The program takes you back to the main window, which you can then close by clicking
on the Close button.

You can select the labeling element you have created in the folder
> User defined under > Manufacturer and call it up for printing.

9.4 Setting up endless labels and strips for thermo transfer printers
Call up the Designer under > Extras > Designer for > Endl labels and stri

(Thermo transfer printer).

The following window opens up:

You can now create new endless labels or endless Bl
strips here by clicking on the New button. User endless Iabels and strips

First enter the name of the label or strip that you = Delete |
want to create in the window.

Now you have to specify whether you want to

create an endless label or an endless strip.
Click on either Label or Strips.

Type oftag
After you click on one of those options, the O Rl

relevant window opens. © smee

|
Close

= Please enter a unigue name for the labels or strips.
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9.4.1 Design an endless label
Enter the width and height of the tag here.

If, on your endless roll, you have more than
one label side by side, enter the number of
labels in the appropriate field.

Endless labels: Label 20x30

rLabel parameter

You must also enter the tag distance in X and Y.

Tag width / height | 000 |/ 000 | mm
Tags per row
Tag distance X/Y [ 0000 | /[ 0000 | mm
Apply I
te la for text and graphic I
Back |

Tag distance X

Tag height

Tag width
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Note:

When the labels are subsequently printed out on a thermo transfer printer, the tag
spacing along the Y-axis is detected by a light barrier. The entry on the tab only serves
to ensure that it displays correctly on the screen.

When you click on the Apply button, the tags you have created are displayed on the
screen.

Having completed the labels, you now also have the option of positioning text fields
and graphic elements on the labels. Creating text fields like this is always useful if you
want to divide the label up into different fields, so that you can later use different text
sizes, font types or symbols on the label.

To do this, click on the Create layout for text and graphic button.

See Section 8 of this manual for a description of how to set up a layout.
After you have specified the layout if you wish, click on Back to close the Layouter.

The program takes you back to the main window, which you can then close by clicking
on the Back button.

Click on Close to close the Designer.
You can select the labeling element you have created in the folder

> User defined under > Manufacturer and call it up for printing.

9.4.2 Design an endless strip
First decide on the size of the strip and enter its length and width.

Then you can divide up the strip using horizontal

Endless strips: strip

and vertical scale factors. - Strp size andlayout

Strip length  width 0,00 | ¢ mm
If required, divide the strip into horizontal sections. e
First of all, specify the height of the first partition, Partiion 1 o T
by entering the height in mm in the > Partition 1 Partiion 2 i Crosswise
field. The remaining height is then transferred into Partiion 3
> Partition 2. In this way you can subdivide the Partiion 4
strip into a maximum of 5 partitions. Parttion 5
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When you have finished dividing the strip into partitions, you first click on the Apply

button. This completes the horizontal division.

After that, you can make a vertical division for each partition. Click on Crosswise for

the relevant strip.
Then the following window opens up:

To enter the required subdivision of the strip,
proceed as follows:

First enter the tag width and then the number of
tags.

By clicking on the Add button, the data is
transferred to the field below. If the strip is not yet
fully divided up, you will be shown the length of strip
that is still available. Now you can specify other tag
widths.

When you click on Apply, the program takes you
back to the previous window and displays the
subdivision that you have specified.

In this way you can subdivide the individual
partitions using different tag widths in succession
as required. When you have finished all the
subdivisions, close the Designer.

—Strip size (mm)
| 1000.00 | X | 10 00
Used width {mm) 200,00
Remaining width
— Partitioning
Width (mm) Mo, of tags
| R
40,00 20
— Edit
Add
Apply |
Cancel |

You can select the labeling element you have created in the folder
> User defined under > Manufacturer and call it up for printing.

Note:

If you have created the labeling data for a strip and are printing out the print data on a
thermo transfer printer, there is the opportunity to define various options for printing.
You can determine whether cutting marks as separating lines or dots should also be

printed.
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10. Import/Export of labeling elements and labels created with

various designer versions

Elements created by the user, as detailed in the preceding sections, can be imported
and exported. This provides an opportunity to swap elements that you have defined
yourself. To export a marking element, click on the Export button and then select the
location where the txt file should be saved. You are advised to use the name of the
element as the file name. Exported files can be imported to another workstation. To
import, click on the Import button and select the file to be imported.

The new element appears in the list of marking elements in the > User defined folder.

If the database already contains an element with the same name, the element that
already exists can be overwritten.

11. Special functions using plotter and engraving versions

11.1 Access of graphic files for plotting or engraving

Graphic files, designed and created by e.g. CorelDraw, can be sent to the plotter or
engraver, assuming the files are saved as .plt file extension (HPGL).

If you like to send the file, please go to > Extras > Send HPGL file from the main

menu. The following window appears: —
| || Search |
Clicking on Search you can browse through the £} b et v
folders selecting the file to be plotted.
Ploti Q
ofting speed (mm/s) 20 - Cancel |

Further settings can be changed:
- Priming on pen change, check click box
- Plotting speed, range 5 to 40 mm/sec

The file will be sent to the plotter by confirming the selection with OK.
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If you like to send the file to the engraver the following window appears:

File name

Clicking on Search you can browse through the | || Semh
folders selecting the file to be engraved. . -
ngraving speed (mm/s) fu
Revolution (RPM) 30000 -
Penetration speed (mm/'s) 4.0 ha
[ o |
= Cancsl |

Further settings can be changed:

- Engraving speed, range 2 to 20 mm/sec
- Revolution (RPM) spindle, range 5000 to 50000 RPM
- Penetration speed, range 2 to 6.5 mm/sec

The file will be sent to the engraver by confirming the selection with OK.

11.2 Scale factor

The data in the database have been carefully entered and checked. However, they are
not subject to regular checking. Thus over time, the tags to be printed could have their
mechanical measurements altered, particularly the scale, i.e. the distances of the
markers from one another in both the x- and y-directions.

Possible influences include workstation temperature and humidity.

However, production influences, such as materials and temperatures when making the
tags, could also have an impact such that there could be deviations from the original
values set. Deviations > 1 mm are quite possible across the entire length and width as
well as a shift in the start point.

In order to make any correction to possible deviations, select from the main menu
> Extras > Shift of start point an rrection of le factor.

If you notice the output on the tag is not centered, you can change the start point and
the scale factor in x- and y-direction accordingly.
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To make a correction, proceed as follows:

Turn on the plotter and select a tag on the segment and then follow the menu path

> Extras > Shift of start point and correction of scale factor. The tags are now all
colored red and the following window appears:

o ,

—Firsttag —Lasttag  Steps

Upper left Lower right Upper left {3 10.00 mm

O 0.025 mm

— — — ~Pen Up/Down

|5 A4 =i T Apply

Reset ‘

|§4|”iﬁﬂ|PUS“iQ” | Initial position Initial position 1

Uil

Cancel '

Insert a plotter pen into the pen holder and click on the button Initial Position in the
far left field.

The plotter moves with its pen to the upper left corner of the first tag. The peak of the
pen needs to match with the corner point.

You can use Pen Up/Down in order to find the exact corner point, with the four cursor
buttons you can move the pen to the exact position; you can set the steps to be
between .025 mm to 10 mm; the default step value is .1 mm.

Then after click on the button Initial Position for the lower right corner of the first tag
and proceed the same way to match the peak of the plotter pen with the lower right
corner of the tag. You can use Pen Up/Down in order to find the exact corner point,
with the four cursor buttons you can move the pen to the exact position.

Page 53 of 59



Then click on the button Initial Position for the very last tag of the matrix bottom right,
the plotter pen moves to the beginning of the last tag, the upper left corner.

You can use Pen Up/Down in order to find the exact corner point, with the four cursor
buttons you can move the pen to the exact position.

After making the amendment, you need to click the Apply button in order to apply the
data; the original database remains unchanged. Close the window and the plotter
goes back to its initial position.

You can return to the original settings at any time by clicking on the Reset button in
the window.
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11.3 Base plates and segments

The plotter has one base plate that can be fitted with various support plates. For this
reason, the base plate is divided into sections known as segments. An A3 plotter has
four segments and an A4 plotter has two segments. You can create several base
plates in one project. Follow the menu path > Edit > Base plate > Add to add a new
base plate. The bottom line of the screen shows the base plates created. It is also
possible to copy base plates and segments.

EH T T T SR SO P B —
NEEHL| SO WMl X 2l i | HEJ|9®™|Q|F| Plot-Job-Plotter full size (DIN A3)
[ [ [w |8 7 U @] s+ e[ [ 15

Segment 1 Segment 2 Segment 3 Segment 4

Base plate 1

g Base plate 1

11.4 Control print of the labeling data

If required, you can print the labels you have created on a base plate on a standard
office printer, for checking purposes.

You can run the print by following the menu path > Extras > Print on paper printer.
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11.5 Calibrating plotter versions

There is usually no need to calibrate the plotter, as all devices are calibrated at the
plant. However, if small deviations occur when printing (labeling is not properly
centered on the tag), there is an option to make small adjustments using manual
calibration. In order to reposition lettering, proceed as follows:

Note:
Make sure that the plotter’s writing arm is able to move freely and that there are
no obstructions, such as a ballpoint pen, on the plotting surface. Follow the menu path

> Qutput > ial features Plotter / Engraver. The Calibration tab will appear.

Special features Plotter / Engrave_
The writing arm moves to a preset Catbration
starting position and four cursor T '
buttons appear in the menu for you to s ETE T
press in order to move the plotter's Point 2 [ 25000 | [ 145000 | 11000mm
writing arm.
The step size can be changed withina || [~ =] A e sty
range of .025 mm to 10 mm. The default B ;| !

step size is set at .1 mm. ® 0100 mm
O 0.025 mm

Calibrate

Q 1.000 mm j ﬂ
v

Reset

Reposition by moving to the right or to

the left, up or down, by clicking on the Close
relevant cursor buttons.

Each click of the cursor button will move the writing arm by the step distance, in this
case .1Tmm.

After completing the adjustment, you need to click on the Calibrate button in order to
apply the new data. After you have successfully completed calibration, close the
window.

You can repeat this step as many times as you like until you achieve an optimum
output.

Click on the Reset button to go back to the original settings. Check the position on the

upper left tag (see > Extras >_Shift of start point and correction of scale factor).

il
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11.6 Assigning the support plate to the marking element

The database for the labeling software contains a large number of marking elements
from different manufacturers. Each marking element is assigned to particular support
plates.

The menu item > Help > Support plates shows which marking elements can be used
with which support plates. There is a wide range of search functions available for
doing this. For example, you can search for a particular marking element and find the
relevant support plate, etc.

12. General information and adjustments

12.1 Zoom function

You can activate and deactivate the zoom function by following the menu path

> View > Zoom function or by clicking on the relevant icon. Click once on the icon and
then take the mouse to the point on the base plate whose view you wish to change.
Left-click with the mouse to select this point as the new central point of the screen
and enlarge the display. Clicking the icon again deactivates the function, thus
enabling you to continue working with the zoom factor that you have now set.
Right-click with the mouse to reduce the size of the screen content.

12.2 Select program language
You can change the program language by following the menu path > Options

> Language settings.

12.3 Display and switching within open project files

You can always obtain an overview of the number of projects and base plates open
from the > Window menu. You can work on as many as 10 projects, with each project
having up to 256 base plates (plotter and engraver). You can use this menu to switch
from one project to another.
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12.4 Standard font type

You can specify a standard font for the different output devices.

By using the menu > Options > Standard font, you can select the font type that you
would like to use as standard for a particular output device.

If you have selected a marking element for labeling, the standard font type is preset.

If you change the font type, then in  *tandard font for Plottcr

future the font type that you last Block_Light =
selected will be retained when you Block_Light_bal 7
use that marking element. Block_Light_ee

m

Block_Light_tr
Block_Light_we
Block_Medium [
Block_Outline

Bonne_

DIMN_1451eng

English_Handwriting

English_0Oldstyle

Era_0Opt

Frutiger_

Frutiger_5&5 :

12.5 Standard pen sizes

Up to four different pen sizes (line thicknesses) can be used in the pen depot on the
Plotter full size (DIN A3) and Plotter half size (DIN A4).

The following configuration is preset: Position 1: .18 mm, Position 2: .25 mm,
Position 3: .35 mm and Position 4: .50 mm.

You can change these settings using the menu item > Options > select standard pen

Sizes.

Click on the Pen Sizes 10 s suds s pn o I

determine which pen sizes

should be used as standard. . .@ .@ . .@ .@ e R
Cancel ‘

0,18 0,50

Select by mouse click four of the six available pen sizes as
standard for the pen station.
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12.6 Software version

Follow the menu path > Help > Info, to find out which version of software for the
labeling program is installed and the database status. If you have connected and
switched on one of the plotter versions or an engraving device, the firmware version
of the device that has been connected will be displayed as well.
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